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1  
Installing and Setting Up 

the Schools Edition 

This Pro/ENGINEER Schools Edition guide provides instructions on the installation, 

implementation, and use of the Pro/ENGINEER Wildfire 4.0 software for teachers and 

students. This guide is subject to change without notice and without any commitment 

by Parametric Technology Corporation (PTC).  
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Overview of Pro/ENGINEER Schools Edition 
Welcome to the Pro/ENGINEER Wildfire 4.0 Schools Edition. PTC hopes that you 

enjoy using the world’s most popular 3D MCAD solution. This guide provides 

instructions on the installation, implementation, and use of the software. The Schools 

Edition Package includes the following items: 

• Pro/ENGINEER Schools Edition software on one CD-ROM.  

• Online Help for English, also on the CD-ROM. Other languages are available 

during an optional setup.  

• Pro/ENGINEER tutorials on the Pro/ENGINEER landing page. 

Usage Guidelines for Schools Edition Software 
Pro/ENGINEER Schools Edition is available to schools in the PTC Schools Program. 

PTC does not offer installation and troubleshooting support. This support is provided 

by your instructor. See http://www.ptc.com/for/education/troubleshooting_faq.htm for a 

FAQ of common questions. Alternatively, students can ask their teacher for assistance. 

If you experience problems during installation, see the Troubleshooting section. 

Note: You cannot use the Schools Edition software for commercial, professional, or for-

profit purposes. The software is not compatible with commercial versions of 

Pro/ENGINEER. 

Languages 
Choose from English, Chinese (Traditional and Simplified), French, German, Italian, 

Japanese, Korean, and Spanish for the Pro/ENGINEER Schools Edition. See the 

installation instructions for installing the desired language. 

File Compatibility of Pro/ENGINEER Editions 
The different editions of Pro/ENGINEER and the compatibility between them are 

shown in the next table.  

Pro/ENGINEER 
Edition Training  Schools  

Schools  
Advanced  

University  
Plus  

Student  Commercial  

Training Data  Yes Yes Yes Yes No* 

Schools Data Yes  Yes Yes Yes No* 

Schools 
Advanced Data 

Yes Yes  Yes Yes No* 

University Plus 
Data 

Yes Yes Yes  Yes No* 

Student Data Yes Yes Yes Yes  No* 

Commercial Data No** No** No** Yes No**  
 

* Requires the use of the Education-to-Commercial conversion tool, a part of University Plus. 

** Requires the data to be saved to educational format via University Plus. 

Features Specific to the Schools Edition 
Pro/ENGINEER Schools Edition is different from the commercial software in the 

following ways:  
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• No access to floating options. 

• Schools Edition banners on the borders of plots and drawings. 

• Online registration and license generation process.  

• No software compatibility with commercial versions of Pro/ENGINEER. Objects 

created with the other Education Editions are compatible. 

Meeting Platform Requirements 
Before installing Pro/ENGINEER Schools Edition, your computer must meet the 

requirements in the next two tables. For platform details, see 

http://www.ptc.com/WCMS/files/52592/en/proewf4.pdf.  

Operating System Service Pack Processor 

Windows XP Professional and 

Home Edition, 32-bit 

Base OS, Service Pack 1 and 2 INTEL Pentium/Xeon family  

Windows Vista, 32-bit  Base OS INTEL Pentium/Xeon family 

 

Minimum platform requirements follow. For computers upgraded from Windows 

95/98/Me to Windows 2000/XP, delete the winbootdir  variable, otherwise 

Pro/ENGINEER fails to start.  

Platform Minimum Requirement 

Main Memory 512 MB (1 GB or higher) 

Available Disk Space 2 GB (Pro/E)  

Swap Space 500 MB (1024 MB or higher) 

CPU Speed Pentium III 700 MHz (1 GB or higher) 

Graphics Cards Cards must support OpenGL. For supported graphics cards, see 

http://www.ptc.com/WCMS/files/52592/en/proewf4.pdf. 

If your graphics card does not support OpenGL, see the section 

Configuring Graphics Acceleration. 

Browser Microsoft Internet Explorer 6.0 SP1 or later 

Network Microsoft TCP/IP, Ethernet network adapter 

Monitor 1024 X 768 (or higher) resolution with 24-bit or greater color 

File Systems NTFS 

Mouse Microsoft approved 3-button mouse 

Distribution Media CD-ROM or DVD drive 

Installing Pro/ENGINEER Schools Edition  
To perform the installation, use the Pro/ENGINEER Wildfire 4.0 Schools Edition CD. 

To streamline the process, connect to the Internet and take the following actions.  
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• Open a PTC online account, if you do not have one. 

• Generate a new software license.  

Logging In with Administrator Privileges 
To open the Pro/ENGINEER Schools Edition starting screen, follow these steps: 

1. Close all applications and disable your screen saver. Failure to do so can produce a 

poorly installed application  

2. Log in as administrator or log on to an account with administrator privileges. 

3. Insert the Pro/ENGINEER Schools Edition CD into your CD-ROM drive. If 

installation does not start, see the Troubleshooting section at the end of this guide. 

The Schools Edition starting screen appears.  
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4. Click the country flag to choose the language for the software installation. The 

Schools Edition information screen appears. 

 
 

 

You must have a PTC online account to generate a license. Create 

your online account now, if you have not already done so. 

Opening a PTC Online Account 
If you already have an online PTC account, skip to the next section.  

1. In the previous screen under Installation Instructions, click PTC online 

account in step 3. The New Account screen opens. 
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2. Fill in any empty text boxes. 

3. Click Create Account. A confirmation screen appears.  

4. Review and print this confirmation. A confirmation of your account is sent to your 

and your parent’s e-mail addresses.  

Generating a New License File 
The method of generating a license file depends on whether the computer on which 

Pro/ENGINEER will run is in a lab environment or is a standalone computer. From the 

Schools Edition information screen shown previously, follow these steps. Advance to 

the appropriate section: 

• Site License—Generate a Floating License—To install a central license server 

to distribute licenses of Pro/ENGINEER to client systems. 

• Standalone License—Generate an Online License—If the computer on which 

Pro/ENGINEER is being installed is connected to the Internet.  

• Standalone License—Generate an Offline License—If the computer on which 

Pro/ENGINEER is being installed is not connected to the Internet. 
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Site License—Generate a Floating License 
With the site license, you can easily install and configure Pro/ENGINEER in the school 

labs. Teachers who have completed the introductory workshop will receive a Site 

License Product Code. Use this code to generate a site license of 100 seats of 

Pro/ENGINEER for the school labs. This licensing method uses a license server to host 

the site license and to provide a valid license to a requesting client. Place the license 

server on a server that is always online. 

Note: The Site License Product Code can only be used on one machine. 

1. With the Site License Product Code available, click 

http://www.ptc.com/go/schools_licensing . A prompt appears.  

2. Log in with your user name and password. The Pro/ENGINEER Schools 

Edition Licensing screen opens. See below. Most of the text boxes are filled. 

3. In the Product Code text box, type the Site License Product Code that you 

received from PTC. 

4. In the HostID text box, type the PTC Host ID for the computer on which the PTC 

License Server will be installed. 

Note: For more information on your Host ID, see the Troubleshooting section. 

5. Click Submit Request. A confirmation screen appears. 

6. Review the information before closing your browser. 

Continue with the next two sections to save your License Pack.  
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Saving Your Floating License Pack  

Your Floating License Pack arrives by e-mail within 2 hours. It contains a file 

attachment named sw_license_email_0000.dat  or something similar. Save the file 

to the offline computer in an easily remembered location, for example, C:\TEMP .  

Note: In some cases, the license file comes embedded in the e-mail text and not as an 

attachment. See the Troubleshooting section to create the required license file.  

Caution: Do not edit the name or contents of this license file. Changes to it make the 

license invalid and prevents Pro/ENGINEER Schools Edition from starting. 

Installing PTC License Server 

1. On the machine that the PTC License Server will be installed on, close all 

applications and disable your screen saver. Failure to do so can produce a poorly 

installed application  

2. Log in as administrator or log on to an account with administrator privileges. 

3. Insert the Pro/ENGINEER Schools Edition CD into your CD-ROM drive. The 

Schools Edition starting screen appears. 

4. On the Schools Edition starting screen, click the language flag for the desired 

language. The School Edition information screen appears. 

5. Click Additional Installations at the bottom of the Schools Edition information 

screen shown previously. The Additional Applications page appears. 

 

6. Download and execute the PTC License Server installation to start PTC.Setup. 

Click Next to begin the installation. 
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To proceed with the installation, read the Pro/ENGINEER license agreement.  

 

7. Select the appropriate box at the bottom of the page. If you accept the license 

agreement, click Next to go to the Select Products to be installed screen. 

Note: If you decline the agreement, PTC.Setup and the installation process stops. 
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8. Click PTC License Server to begin the installation. The Define Installation 

Components screen appears. 
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9. Click the folder to the right of the License File text box and browse to the 

directory with your Pro/ENGINEER Schools Edition license file. The Select File 

dialog box opens.  
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Note: To be prepared for a reinstallation, write down in a safe place the path of the 

license file. PTC strongly recommends this action. 

10. Click Open. You are returned to the Define Installation Components screen. 

11. Click Install to start the installation process, or choose one of the following 
options: 

– Click Back to review information.  

– Click Install to begin installation. 

– Click Exit to cancel PTC.Setup. 

The Installation Progress screen opens. During installation, you can click Exit at 

any time to stop the installation process. 

Installing Pro/ENGINEER Schools Edition on a Lab Co mputer 

To open the Pro/ENGINEER Schools Edition starting screen, follow these steps: 

1. On the lab computer, close all applications and disable your screen saver. Failure 

to do so can produce a poorly installed application  

2. Log in as administrator or log on to an account with administrator privileges. 

3. Insert the Pro/ENGINEER Schools Edition CD into your CD-ROM drive. The 

Schools Edition starting screen appears. 
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4. On the Schools Edition starting screen, click the language flag for the desired 

language. The School Edition information screen appears. 

 

5. Click Install Now to start PTC.Setup. Accept the License agreement to proceed 

with the install. 
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6. Click Pro/ENGINEER to install the Pro/ENGINEER Schools Edition software. 

The PTC.Setup screen for License Configuration appears. 

 

7. Under the Specify License Server area, click that option. Type the Hostname of 

the machine on which the PTC License Server is installed. Specify the Port (7788 is 

the default port).  

8. Click Next. The Define Installation Components screen appears.  

Note: Now skip to the section Selecting Additional Languages to Install. 



Installing and Setting Up the Schools Edition 1-15 

Standalone License—Generate an Online License 
1. Click Install Now to begin the installation for Pro/ENGINEER Schools Edition. 

The PTC.Setup screen appears. Click Next to begin the installation. 

Note: During installation, you can click Exit at any time to stop the process. 
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To proceed with the installation, read the Pro/ENGINEER license agreement.  

 

2. Select the appropriate box at the bottom of the page. If you accept the license 

agreement, click Next to go to the Select Products to be installed screen. 

Note: If you decline the agreement, PTC.Setup and the installation process stops. 
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3. Click Pro/ENGINEER to install the Pro/ENGINEER Schools Edition software. 

The PTC.Setup screen for License Configuration appears. 

 

4. Click Generate License File. A prompt appears. 

5. Log in with your user name and password. PTC.Setup uses your PTC HOST ID 

and Schools Edition ID to generate the license file. The path appears in the 

License File Path box. 

6. Click Next. The Define Installation Components screen appears. Accept the 

defaults and click Next 

Note: Now skip to the section Selecting Additional Languages to Install. 
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Standalone License—Generate an Offline License  
Note: This section is for offline license creation only  

1. Click Install Now to start PTC.Setup to obtain the PTC HostID.  

2. From the bottom-left corner of PTC.Setup, write down the PTC HostID. You use 

this ID to generate the offline license. 

 

Perform the following steps to generate the license on a computer connected to the 

Internet and not on the computer on which you will be installing Pro/ENGINEER. 

3. Insert the Pro/ENGINEER Schools Edition CD into your CD-ROM drive. The 

Schools Edition starting screen appears. 
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4. Click the country flag to choose the language for the software installation. The 

Schools Edition information screen appears. 

 

5. Click Generate License for Offline Mode at the bottom of the Schools Edition 

information screen shown previously. A prompt appears.  

Log in with your user name and password. The Pro/ENGINEER Schools 

Edition Licensing screen opens. Most of the text boxes are filled, except for the 

HostID.  
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6. In the Host ID textbox, type the PTC Host ID for the computer on which the 

Schools Edition will be installed. This is the number you wrote down in step 2.  

Note: For more information on your Host ID, see the Troubleshooting section. 

7. Click Submit Request. A confirmation screen appears. 

8. Review the information before closing your browser. 

Continue with the next two sections to save your License Pack. Then you can install 

the Schools Edition on your offline computer. 

Saving Your License Pack for Offline Use of Pro/ENG INEER  

Your License Pack for offline use arrives by e-mail within 2 hours. It contains a file 

attachment named sw_license_email_0000.dat  or something similar. Save the file 

to the offline computer in an easily remembered location, for example, C:\TEMP .  

Note: In some cases, the license file comes embedded in the e-mail text and not as an 

attachment. See the Troubleshooting section to create the required license file.  

Caution: Do not edit the name or contents of this license file. Changes to it make the 

license invalid and prevents Pro/ENGINEER Schools Edition from starting. 

Installing Pro/ENGINEER Schools Edition on the Offl ine Computer 

To open the Pro/ENGINEER Schools Edition starting screen, follow these steps: 

1. On the offline computer, close all applications and disable your screen saver. 

Failure to do so can produce a poorly installed application  

2. Log in as administrator or log on to an account with administrator privileges. 

3. Insert the Pro/ENGINEER Schools Edition CD into your CD-ROM drive. The 

Schools Edition starting screen appears. 

4. On the Schools Edition starting screen, click the language flag for the desired 

language. The School Edition information screen appears. 

5. Click Install Now. 
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6. Click Pro/ENGINEER to install the Pro/ENGINEER Schools Edition software. 

The PTC.Setup screen for License Configuration appears. 

 

7. Click the Folder icon to the right of the License File Path box. The Select File 

dialog box opens. 

8. In the Type list, change the file type from *.txt  to *.dat . 

 

9. Browse to the directory with your Pro/ENGINEER Schools Edition license file as 

shown in the Select File dialog box. The directory (Folder) path depends on where 

you saved your license file. It may not appear exactly as in the example. 
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10. Select the license file and then click Open. The Select File dialog box closes the 

path appears in the License File Path box on the PTC.Setup screen for License 

Configuration. 

Note: To be prepared for a reinstallation, write down in a safe place the path of the 

license file. PTC strongly recommends this action.  

11. Click Next. The Define Installation Components screen appears. Accept the 

defaults and click Next.  

Selecting Additional Languages to Install 
In the Define Installation Components screen, you can choose additional languages 

to install.  

1. Expand Languages folder.  

2. Right-click a desired language and click Install this Feature from the shortcut 

menu.  
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The options on the Define Installation Components screen follow. 

Option Description 

Destination Folder C:\Program Files\ProENGINEER  Schools Edition . To 

change this default location, type another path, or click Browse to 

select another path.  

PTC strongly recommends a new installation. The path cannot be 

an existing PTC directory, or PTC.Setup assumes you are trying to 

update or reconfigure Pro/ENGINEER Schools Edition.  

Platforms  The only platform available in Pro/ENGINEER Schools Edition is 

i486_nt. This option is the default. 

Languages  Check any additional languages for installation. Additional 

language packs require more hard drive space. 

Pro/ENGINEER (default) Keep this component to install the files necessary to run the 

software for Pro/ENGINEER Schools Edition. 

 

3. When finished specifying the installation directory, click Next. The Select Units 

screen appears. 
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Defining Units of Measure 
In the Select units screen shown below, you define your desired units of measure.  

 

1. Select either English or Metric (default). 

2. Click Next. The Windows Preferences screen appears. 
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Defining Windows Preferences 
1. In the Windows Preferences screen shown below, you define your Windows 

preferences.  

 

2. Select your Shortcut Locations. 

3. In the Startup Directory text box, type the full path for the startup directory of 

Pro/ENGINEER. 

Note: The default location for the startup directory is the My Documents folder of 

the user who is installing the edition. Change the directory to a location with 

read/write access, for example, C:\default . 

4. Under Windows Environment Preferences, choose to modify the system 

environment for all users or the current user. 
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Completing Pro/ENGINEER Configuration and Installat ion 
You have almost completed the Pro/ENGINEER installation. To proceed, click one of 

the following commands: 

• Click Back to review information.  

• Click Install to continue installation. 

• Click Exit to stop the installation. 

 

When Pro/ENGINEER stops, click Exit. 

Congratulations! You can now use Pro/ENGINEER Wildfire 4.0 Schools 

Edition. 
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Configuring and Setting Up Pro/ENGINEER 
Pro/ENGINEER provides a highly customizable environment with configuration files 

to define system-specific and application-specific settings, such as required drafting 

standards and system color schemes. If a configuration option is in more than one 

configuration file, Pro/ENGINEER applies the most recently loaded or recently read 

setting. 

• Protected system configuration files—At startup, Pro/ENGINEER first reads 

in a protected system configuration file called config.sup . The configuration 

option settings in this file cannot be overwritten by the config.pro file of an 
individual user .  

• Configuration files—Next, Pro/ENGINEER searches for and reads in 

configuration files config.pro, config.win, and menu_def.pro  from the 

following directories in the following order: 

– <loadpoint>/<filename>—Pro/ENGINEER installation directory. Your 
system administrator can put configuration files here to support company 

standards for Windows configuration settings, formats, and libraries. Users 

starting Pro/ENGINEER from this load point, use the values in this file. 

– Login directory—The home directory  for your login ID. By placing your 

configuration files here, you can start Pro/ENGINEER from any directory. You 

do not need to a copy of the configuration files in each directory. 

– Startup directory—Your current or working directory when you start 

Pro/ENGINEER. 

• Local configuration files—Last to be read are config.pro , config.win , and 

menu_def.pro  in your startup directory. Therefore, they override any conflicting 

configuration file option entries on your computer. 

Using config.sup and config.pro Files 
You can create and store custom configuration files in your working directory. These 

files can apply to specific projects or to individual user settings. 

Config.sup 
Config.sup  is a protected system configuration file. Use this file to ensure that 

students cannot change configuration settings, such as specified templates, directory 

settings, and so forth. The system administrator sets configuration options in the 

config.sup  file for school-wide use. Values in this file cannot be overridden by the 

config.pro file.  

Note: The config.sup file must be in the text  directory in the Pro/ENGINEER load 

point. 

To ensure the config.sup  is always correct and up-to-date, create a .bat  file to start 

Pro/ENGINEER and copy the config.sup file to the local computer's text directory. 

An example of a .bat  file is in the section Using Trail Files. 

Config.pro 
By default, Pro/ENGINEER uses a set of predefined config.pro  settings. When you 

make modifications to the default settings, a config.pro  file is created in 

C:\Program Files\proeWildfire 4.0\text\.  An example config.pro  file is in 

the pro_standards\config_files  directory. 
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Creating Configuration Options 

To view, modify, or add config.pro  settings, follow these instructions: 

1. On the main toolbar of Pro/ENGINEER, click Tools > Options. The Options 

dialog box opens. 

2. Clear the Show only options loaded from file check box. All options are 

available. 

3. Click one or more configuration options from the left column to apply them. 

4. Click Apply.  

5. Save a backup copy of this file to a secure backup directory or disk. 

Configuring Graphics Acceleration 

One entry in the config.pro  is for graphics cards. The default is set as follows: 

use_software_opengl = yes, so that  Pro/ENGINEER uses OpenGL software 

for graphics.  

Setting the Config.pro Files 

• .dtl—By default Pro/ENGINEER sets the drafting standard to ASME / ANSI. To 

use another standard, add a setting into the config.pro  file to point 

Pro/ENGINEER at the required standard. The config.pro  option is 

drawing_setup. Country-specific files are provided for your convenience. 

– UK—BS8888.dtl  in pro_standards\config_files   

– Australia—AS1100.dtl  in pro_standards\config_files   

• tree.cfg—The tree.cfg  file controls how information is displayed in the Model 

Tree. This file is in pro_standards\config_files. You can select the 

particular tree.cfg  file by setting the mdl_tree_cfg_file  configuration option 

in the config.pro  file by browsing for the specific file. 

• syscol.scl—To change the color scheme for Pro/ENGINEER, click View > Display 

Settings > System Colors. The color scheme is saved in the syscol.scl  file. An 

alternative syscol.scl  file is in the pro_standards\config_files  directory. 

To use this syscol file, add the configuration option system_colors_file  into 

your config.pro  file and point it at the required file. 

Note: You can use a sample syscol.scl  file for making Pro/ENGINEER 

drawings with a white background like Pro/DESKTOP. To enable this color 

scheme, set the system_colors_file  into your config.pro  file and point it at 

the required file in the pro_standards\config_files  directory. You must 

restart Pro/ENGINEER for the changes to take place. 

• config.win—The config.win  file is a database file. It stores window 

configuration settings, such as toolbar visibility and Model Tree location. 

Using Trail Files 
Every session of Pro/ENGINEER creates a trail file. This file contains all user actions 

in that session of Pro/ENGINEER. Delete these trail files on a regular basis to free up 

disk space. By default these trail files are created in the Start in directory defined 
within the Pro/ENGINEER shortcut icon. To view or change this configuration option, 

right-click the Pro/ENGINEER icon and choose Properties. 

IMPORTANT: The best location of the trail file directory is on the hard drive of the 

local computer. Pro/ENGINEER records every command and option in the trail file. 

Using the trail file directory over the network causes high network traffic. To write the 
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trail files directly to the temp  directory of the local computer, add the configuration 
option called trail_dir = %TEMP%  to the config.pro  file. 

Setting Search Paths 
Pro/ENGINEER requires a list of directories in which to search for file types, such as 

parts or drawings. By default Pro/ENGINEER looks in the current working directory. 

If parts and assemblies are in other directories, you must list the path explicitly in the 

config.pro  or the search_path.pro . If you want to use the search_path.pro  

configuration option, the path to search_path_file  must be in the config.pro  file. 

PTC recommends using the full path for all directories. For example; consider the 

directory structure in the next figure.  

 

 

The search path entries required in either the config.pro  file or the 

search_path.pro  file are as follows: 

E:\shared\pro_standards\part_libraries\Batteries 

E:\shared\pro_standards\part_libraries\Fasteners 

Note: All students must set their own working directory within Pro/ENGINEER to the 

specific project. Therefore, teachers need not add design project directories for 

students, such as Boat  and Car , to the search path.  

Pro/ENGINEER does not search subfolders or subdirectories. Every folder or directory 

with Pro/ENGINEER files must be included in search_path.pro . Pro/ENGINEER 

searches for files in a specific order: 

• In session (files opened and then closed but not erased) 

My Computer 

C (local drive) D (local drive) E (network 

drive) 

User Profiles 

Car Boat 

Car_assy.asm 

Wheel.prt 

Axle.prt 

Boat_assy.asm 

Hull.prt 

Cabin.prt 

Mast.prt 

Shared 

pro_standards 

Fasteners Batteries 

AAA.prt 

AA.prt 

screw.prt 

nut.prt 

Washer.prt D.prt 

templates 

proe_trail_files 

Part_libraries hole_tables 

A0_format.frm 

A3_format.frm 

Solid_start_part_mm

.prt 

start_assembly_mm.

asm 

ISO_coarse.hol 

trail.txt.1 

trail.txt.2 

trail.txt.3 
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• In the directory from which the file or assembly is specifically opened 

• In the defined working directory 

• In directories listed in the search_path.pro  file 

To ensure you are always using the correct Pro/ENGINEER files, erase the files that 

are not displayed. See the section Erasing Files in Pro/ENGINEER. 

Using Template Files 
Pro/ENGINEER uses a number of template files whenever you create a new part, 

assembly, or drawing. The default template files are in the template directory within 

the Pro/ENGINEER program directories. The default templates are all in Imperial 

units, for example, inlbs_part_solid.prt  and e_drawing.drw . 

For metric versions of files, add the following configuration options into your 

config.pro  file and set the entry to point at the required files. 

• template_designasm —Specifies the designated template assembly 

• template_drawing — Specifies the drawing used as the default drawing template 

• template_solidpart —Specifies the model used as the defaults part template 

Note: Please see the pro_standards  section. 

To use customized templates, such as drawing formats, create a single shared directory 

for all the templates. See the suggested directory structure in the next section. PTC 

provides example metric start parts and ISO drawing formats under the 

pro_standards/templates  directory. 

Developing a Directory Structure 
The default Pro/ENGINEER directory is C:\Program Files\ProENGINEER 
Schools Edition . All the default template files, such as start parts and Imperial 

drawing templates, are in ProENGINEER Schools Edition\templates.  Default 

configuration settings do not require a config.pro  file or anything else. However, if 

you make any modifications to the config.pro  file, create the relevant configuration 

file in C:\Program Files\ProENGINEER Schools Edition\text . 

As an instructional aid, sample configuration files, start parts, drawing templates, and 

other files are under Program Files\ProENGINEER Schools 
Edition\pro_standards.  

For all students to have access to the same data, you can place the pro_standards  

directory on a network drive. Then, make the relevant settings of the configuration 

options in the config.pro  file point at this network directory. 

Using Pro_Standards in Classrooms 
To help implement Pro/ENGINEER Wildfire Schools Edition, PTC works with teachers 

around the world to provide preconfiguration for easier deployment within the 

classroom. A preconfiguration directory called pro_standards  is in the 

<loadpoint>\ProENGINEER Schools Edition\ directory.  

Within the ProENGINEER Schools Edition  directory are the following directories: 

config_files 
hole_sizes 
material_database 
part_libraries 
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templates 
trail_files  

Copy the pro_standards  directory to a centrally accessible drive or directory. All 

students can then access common templates, part libraries, configuration options, and 

so forth. The purpose of each directory, its contents, and how to use it follows. 

config_files 
Pro/ENGINEER Wildfire uses different files to configure how Pro/ENGINEER looks 

and functions. Typically a Pro/ENGINEER System Administrator with knowledge of 

configuration options sets up these files. To help teachers implement Pro/ENGINEER 

Wildfire Schools Edition, a preconfigured set of configuration files comes with the 

software. You can modify the preconfigured files as you become more familiar with 

Pro/ENGINEER's operation. 

config.pro 
One of the most important configuration files in Pro/ENGINEER is the config.pro 
file. This file must be on each computer under <loadpoint>\ProENGINEER Schools 
Edition\text\ . The teacher or an IT (Information Technology) Administrator should 

modify the config.pro  within Pro/ENGINEER to suit educational requirements. 

Save the file in a secure location, and copy it to each computer running 

Pro/ENGINEER. 

The config.pro  file contains a list of directories that Pro/ENGINEER searches to find 

drawing formats, drafting standards, templates, and so forth. The teacher or IT 

Administrator must edit the relevant directory settings within the config.pro  file. 

For example, the configuration option template_solidpart  specifies which template 

file that Pro/ENGINEER uses for new parts. Provide the full path in the configuration 

options. 

Note: If you have moved the pro_standards  directory to a centrally accessible drive 

or directory, modify this setting to point Pro/ENGINEER at the new location. 

To modify the config.pro file , follow these steps: 

1. Start Pro/ENGINEER. 

2. Click Tools > Options. 

3. Choose each option and modify its value.  

4. Click Add/Change after each change.  

5. Click Apply or OK. The newly modified config.pro  file is saved for future use 

Note: You must copy the final config.pro  file onto every computer running 

Pro/ENGINEER. Place it in the directory <loadpoint>\ProENGINEER Schools 
Edition\text\ . 

search_path.pro 
The search_path.pro file specifies where Pro/ENGINEER searches for any parts, 

assembly files, and other files that are not in the working directory. In Word Pad or 

Note Pad, you can edit the search_path.pro  file. Use the full path for the 

configuration option. A search_path.pro  file comes with the software. It contains the 

paths to sample parts, such as, pro_standards/part_libraries/fasteners.  

The location of the search_path.pro  file is specified in the config.pro  file. You 

must modify the path in this file to suit your own directory structure. 
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bs8888. dtl  
Pro/ENGINEER does not come with a predefined UK BS8888 drafting standard. The 

bs8888.dtl  file for the Schools Edition configures Pro/ENGINEER's drafting 

functions to replicate the BS8888 drafting standard. 

 iso.dtl 
A copy of the ISO drafting standard configuration file, iso.dtl , comes with 

Pro/ENGINEER Schools Edition. The installation of the Schools Edition copies it into 

the pro_standards  directory. This location ensures that students are using the same 

iso.dtl  file. 

lay0001.pro 
The lay0001.pro  configuration file specifies on which layers to place specific entities 

such as datum planes. 

syscol.scl 
The syscol.scl  configuration file defines the colors for use for different types of 

geometry, graphics, text, and so forth, in Pro/ENGINEER. 

tree.cfg 
The tree.cfg  configuration file determines what Pro/ENGINEER displays or hides 

within the Model Tree. For Pro/ENGINEER to find these configuration files, you must 

specify their location in the config.pro  file. 

hole_sizes 
With Pro/ENGINEER, you can insert standard holes, that is, M10 tapped hole with a 

countersink. Pro/ENGINEER comes with a set of ISO, UNC, and UNF tables of hole 

sizes. An ISO coarse table contains the most commonly used ISO hole sizes. You must 

set the config.pro  option of hole_parameter_file_path  with the 

ISO_coarse.hol  file to point at your centrally located pro_standards  directory. 

Otherwise, Pro/ENGINEER does not find the file.  

material_database 
With solid modeling in Pro/ENGINEER, you can represent parts and assemblies as 

real solid components with accurate Mass properties. You can assign a diverse range of 

material properties to each solid part. Pro/ENGINEER comes with a sample set of 

materials that are in the directory <loadpoint>\ProENGINEER Schools 
Edition\text\materials-library . You can also define additional materials and 

store them in this central directory. 

You can provide student access a common material library. Copy the contents of this 

directory into the centrally accessible pro_standards\material_database  

directory. 

To find the pro_standards\material_database  directory, set the config.pro  

option of pro_material_dir  to point at your centrally located 

pro_standards\material_database  directory. 

part_libraries  
As part of best practice, use standard parts. For example, an assembly can contain a 

number of nuts and bolts. Rather than have students create their own models of a nut 

or bolt, you can have them use standard sets of nuts and bolts. Sample part libraries 

for nuts, screws, and commonly used batteries come with the software. 
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To find the part_libraries  directory, you must add the full path names of each 

directory to the search_path.pro  file. For classroom installations, place this 

directory on a central server. 

templates 
For use in classrooms, place the template directory on a central server. When creating 

a new part, assembly, or drawing, Pro/ENGINEER uses templates, or start parts. 

These templates have predefined units, drawing borders, and so forth. Pro/ENGINEER 

comes with a default set of Imperial start parts and drawing formats. A metric set of 

sample start parts and drawing formats is also available. 

To include these template files in the Pro/ENGINEER user interface, you must set the 

relevant configuration options in the config.pro  file with the path to the 

pro_standards\templates  directory.  

start_model_dir 
template_solidpart 
template_designasm 
template_drawing  

trail_files  
Every time you starts a session of Pro/ENGINEER, a trail file is created. This trail file 

records all actions during that session. These trial files accumulate, and you must 

delete them. To make the deletion easier, follow these steps: 

1. Create a trail_files  directory within each user account.  

2. Set the configuration option to direct Pro/ENGINEER to create the user-specific 

trail files in the appropriate user-specific directory. 

3. Set a trail_dir  configuration option in the config.pro  file to point at the users 

own trail_files directory. 

Managing Files and Your Work Environment 
You can manage your files and work environment in a number of ways.  

Using Pro/ENGINEER File Types 
The most widely used file extensions in Pro/ENGINEER are as follows: 

.prt —part files 

. asm—assembly 

. drw—drawing 

. frm—drawing format 

Naming Files 
A name of a file, feature, drawing view, datum plane, sketch, or any file within 

Pro/ENGINEER cannot contain any of the following characters: & / . , ; : # % $ ( ). In 

addition, you cannot use a space in a file name, as in top bracket.prt . Use an 

underscore (_) instead as in top_bracket.prt . 

Pro/ENGINEER does not differentiate between uppercase of lowercase characters. For 

example, when opening a new part, you enter the file name Front_Wheel.prt . 

Pro/ENGINEER sees and refers to this part as FRONT_WHEEL.PRT, and on disk this 
part is seen as front_wheel.prt.  
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Erasing Pro/ENGINEER Files 
Pro/ENGINEER holds the part, assembly, or other file in memory after you save and 

close it. Erase files from memory when you have finished with them. To remove a file 

from memory, click File > Erase > Not Displayed and choose the file to erase. 

Otherwise, when you open a file, Pro/ENGINEER first searches for it in memory and 

could open an unwanted file, as the example below explains.  

Suppose that you open wheel.prt  from C:/my documents/projects/car  and then 

close it. Next, you change directory to C:/my documents/projects/truck  and 

select a file call wheel.prt  from this directory. Pro/ENGINEER looks first in memory, 

sees a file called wheel.prt , and opens that file. As a result, the part of the wheel of 

the truck and not the wheel of the car opens.  

Working with Versioned Pro/ENGINEER Files 
Every time you save a file in Pro/ENGINEER, a sequential version of the file is 

created. For example; if you open a newly created part called antenna.prt  and save 

it, antenna.prt.1  is created, and then antenna.prt.2  and so on with each 

successive save. These versioned files can consume disk space. Purge files on a 

frequent basis on each directory with part files, assembly files, and drawing file.  

Troubleshooting 
Common questions and answers can help you get up and running with your 

Pro/ENGINEER Schools Edition. For additional troubleshooting assistance, see the 

Troubleshooting FAQ for the PTC Education Programs on the Schools Program page. 

Setup did not begin when I inserted the CD. What do  I do? 
If PTC.Setup does not begin automatically, follow these steps: 

1. Click Start > Run on the Windows task bar. The Run dialog box opens. 

2. Click Browse. The Browse dialog box opens. 
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3. For the Look in list box, click the down-arrow and select your CD-ROM drive. 

4. Click LAUNCH.EXE in the File name box. The path d:\setup.exe  (where d 
designates your CD-ROM drive) appears in the Run dialog box. 

5. Click Open in the Browse dialog box. After the path appears in the Run dialog 

box, click OK. The Schools Edition starting screen appears. 

How do I locate my computer’s Host ID?  
The Pro/ENGINEER Schools Edition license is locked to the Host ID (physical address) 

of your computer. To find out your Host ID, click Start and choose Run. In the Run 

dialog box, type cmd and press RETURN. In the DOS window, type ipconfig/all . 

Look for the network Physical Address for your Host ID. The Host ID also appears in 

the bottom-left corner of the first screen in the Pro/ENGINEER installation. 

1. Insert your Pro/ENGINEER Schools Edition CD-ROM in to the CD-ROM drive of 

the computer on which you want to install Pro/ENGINEER. Start PTC.Setup as 

outlined in the Installing PRO/ENGINEER WILDFIRE 4.0 Schools Edition section. 

On the first installation screen, in the lower-left corner, you will see a 12-digit 

number on the second line similar to the that in the figure below. The number on 

your screen is your Host ID. 

 

The 12-digit number on the second line is your Host ID. 

2. Open a Windows command prompt (Start > Run, type cmd, and press ENTER.)  

3. At the C:\> prompt, type ipconfig /all  and press ENTER. The Windows IP 

Configuration information appears. 

4. Locate the line with the words Physical Address. This is your Host ID: 

Physical Address. . . . . . . . . : 00-11-22-33-44-55 

What does the error in plpfhost mean?  
A plpfhost  error can occur for one of two reasons: 

• A required Ethernet network adapter is not installed or configured properly. See 

your hardware vendor for installation and configuration information. 

• Media Sense within Windows causes the PTC Host ID (Ethernet network adapter 

address) to not be detected. It disables the network card. Use the instructions in 

the Windows document Q239924 to disable media sensing. 

Why does my Schools Edition not start? 
If your computer was upgraded from Windows 95/98/Me to Windows 2000/XP, the 

variable winbootdir  could have been preserved rather than deleted. Delete the 

winbootdir  variable and your Pro/ENGINEER Schools Edition will start. 

What does the message “Could not detect network ada pter” mean? 
See your hardware vendor for information on installing and configuring the 

network adapter if you get this message: Could not detect network adapter . 

An Ethernet network adapter is required to start the Pro/ENGINEER Schools 

Edition. 
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Why does Pro/ENGINEER not find the load point at st artup? 
If you get the message Cannot Find <Loadpoint>\i486_nt\filename , the PATH 
environment variable for the Pro/ENGINEER load point is either is not set or is 

incorrect. You may have a syntax or spelling error. To correct this, follow these steps: 

1. Click Start > Settings > Control Panel. (For Windows XP, click Start > Control 

Panel). The Control Panel appears. 

2. Double-click System. (XP users, if you do not see System in the Control Panel, 

click Switch to Classic View in the upper-right corner.) 

3. Click the Advanced tab and click Environment Variables. The Environment 

Variables page appears. 

4. Look under System variables for the variable PATH. Check to see if PATH 
contains <loadpoint>\bin.  (All values are separated by a semicolon. Therefore, 

if there are other paths before and after Pro/ENGINEER, the Pro/ENGINEER path 

will have semicolons both before and it). 

Note: The load point is the directory into which Pro/ENGINEER was installed. If 

you accepted the default location, then your load point will be C:\Program 
Files\ProENGINEER Schools Edition . If you installed Pro/ENGINEER into a 

directory other than the default load point, you must reflect that change. 

5. Between the semicolons, fix the PATH variable to the correct location of your load 

point. 

What happens when the offline license is embedded i nto the e-mail from PTC?  
Depending on your e-mail provider, when you generate a licence via the offline method, 

you might receive an e-mail with the license file embedded. Typically, the license file is 

included as an attachment. To generate your license, please select and cut (CTRL+C) 

the text, which is similar to the text shown below. 

Caution: Do not edit or change any information in the text or it will corrupt the 

license file.  

In WordPad, paste (CTRL+V) the selected text and save the file with the name 

license.txt . During installation of Pro/ENGINEER, you will browse to this file. 

######### Pro/ENGINEER Schools Edition 4.0 ######## # 
#Feature Line Type  = INCREMENT 
#Feature Name   = PROE_Schools 
#Feature Version  = 29.0 
#Version   = Wildfire 4.0 
#Number of Copies  = uncounted locked license 
#Supercede   = Y 
#Issue Date   = 05-MAY-2008 
#Expiration Date  = 01-JAN-0 
#Node Locked Option  = Pro/FEATURE 
#Node Locked Option  = Pro/DETAIL 
#Node Locked Option  = Pro/INTERFACE 
#Node Locked Option  = WLO 
#Node Locked Option  = Pro/PLOT 
#Node Locked Option  = Pro/REPORT 
#Node Locked Option  = Pro/PHOTORENDER 
#Node Locked Option  = Pro/SHEETMETAL-DESIGN 
#Node Locked Option  = Mechanism Design License 
#Node Locked Option  = Behavioral Modeling License 
#Node Locked Option  = Design Animation License 
#Node Locked Option  = Advanced Rendering Extension  License 
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#Node Locked Option  = Pro/ENGINEER Language Option  License-CHINESE 
#Node Locked Option  = Mechanism_Dynamics - Module 
#Node Locked Option  = Pro/Schools 
 
INCREMENT PROE_Schools ptc_d 29.0 05-may-2010 uncou nted \ 
  B080C090187231CD23AA VENDOR_STRING="VSVER=2.0 \ 
  LO=(7,10,17,19,34,51,73,115,127,128,137,148,155,1 91,233) \ 
  " HOSTID=PTC_HOSTID=< YOUR HOSTID> SUPERSEDE \ 
  ISSUER=PTC-WEB-PTCSCHOOLS4 ISSUED=05-MAY-2008 \ 
  NOTICE="< Your Name>" SIGN2="1EF2 C6E3 531E F01D 4177 \ 
  C471 3D80 F1C3 2627 2705 D81C 7456 E266 2C9E 3DB7  \ 
  11BA 0F94 35C9 098C 0232 3FCA 4343 6733 A55A B990  \ 
  B33B 356B B452 20C 


